[bookmark: _Hlk519256657][bookmark: _top]My Initial Personal 
Education Plan
Newly arrived unaccompanied asylum-seeking children (UASC)
This PEP is designed for newly arrived UASC; it does not contain detailed information on academic progress. It can be used for all age groups.   
Additional support and guidance: http://www3.hants.gov.uk/emtas
http://www3.hants.gov.uk/education/emtas/supportinglanguages/ambassadorscheme

http://documents.hants.gov.uk/education/EMTASAsylumseekersandrefugeechildrenincountyGuidance2014-09-11.pdf

http://documents.hants.gov.uk/education/EMTASUASCguidanceforschoolsoutsideofHampshire.pdf


 




Click here for general guidance on completing this PEP or if the document is in protection mode and you cannot enter text into the fields 
Within 4 weeks of PEP meeting all sections to be complete and emailed to the child’s social worker 
and for HCC CIC to HCC.PEPs@hants.gov.uk 
for IOW CIC to Virtual School via SharePoint or for schools not on the IOW to virtual.school@iow.gov.uk
	Click here for guidance on completing this section 

	PEP Type: 
	Choose an item.
	Meeting Date: 
	Click here to enter a date.

	School Name:
	Click here to enter text.
	DfE Number:
	Click here to enter text.

	Designated Teacher Name:
	Click here to enter text.
	Designated Teacher email:
	Click here to enter text.

	School age range:
	Choose an item.
	Date of enrolment:
	Click here to enter a date.

	IOW/HCC District:
	Choose an item.
	LEA (if not IOW or Hants):
	Click here to enter text.

	Social Worker name:
	Click here to enter text.
	Social Worker email:
	Click here to enter text.

	Social Care District:
	Choose an item.
	Social Care Team:
	Choose an item.



	
Personal information can be completed without the child/young person present (possibly in advance)
	Click here for guidance on completing this section



	[bookmark: Section_1_part_2]Essential Information about me from my social worker
	Click here for guidance on completing this section

	[bookmark: Section_1_part_4]Summary of my care plan. My social worker must add detail related to my history that will support the school and other agencies in fully understanding my past & meeting my needs
	Click here for guidance on completing this section

	[bookmark: Section_2a_part_2]Contacts and Permissions - Maintained by social worker
	Click here for guidance on completing this section

	
	

	[bookmark: Section_2a_part_3]Who will say I can go on school trips?
	Click here for guidance on completing this section

	Social Worker to detail the adults who should have copies of this PEP:
	Click here for guidance on completing this section





	[bookmark: Section_2]Section 2 All of section 2 pages should be completed with the young person involved, and wherever possible in attendance at the meeting

PEOPLE INVOLVED IN MY PEP (THOSE WHO MUST ATTEND ARE IN BOLD)
	Click here for guidance on completing this section

	Person
	Name Only (please do not enter email addresses unless a privacy notice or consent to share has been signed as per GDPR)
	Present

	

	[bookmark: Section_2c]Section 2 can be completed without the child/young person present (possibly in advance) and discussed/ shared with them in the PEP meeting
	Click here for guidance on completing this section 

	Section 2 Comments from my education settings relating to: Barriers to Learning (informed by PEP Needs Analysis & PEP Toolkit)
	Click here for guidance on completing this section



	[bookmark: Section_3a]Section 3a: Pupil Voice:
These are key points that I would like to share to inform the meeting and my action plan. They can be typed in for me after our discussion. Any drawings or photos can be added as an attachment.
	Click here for guidance on completing this section


	[bookmark: Section_3b]Section 3b can be sent out in advance of the PEP to enable parent/carers to prepare for the PEP meeting
	Click here for guidance on completing this section

	What my Carer/Parent/Guardian thinks:
	



	[bookmark: Section_3c][bookmark: Section_3d]Section 3c    Action Plan:  My Targets (SMART) – Specific, Measureable, Achievable, Realistic, Time related.  They must link to young person’s comments, parent/carer actions, needs analysis & attainment and progress & should be written up by Designated Teacher as an outcome of discussion at the meeting
	Click here for guidance on completing this section



	[bookmark: Section_4]Section 4: My School’s summary of how funding has been used to meet my needs - with breakdown of costs and evaluation of impact
	Click here for guidance on completing this section




	Please use this page to attach any relevant documents to do this from the Office Ribbon:	
“Insert”, “Text”, “Object”, “Object…”
Or from the Keyboard:		Alt, Alt + N, Alt + J, Alt + J and then from the dialog:	Create from File, Browse for file, tick “Display as icon
	
Click here for guidance on completing this section
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Guidance page 1														Return to the top of the document
How to complete this PEP data form: Many Virtual Schools have moved in recent years to a PEP data form (PEP). In Hampshire & the Isle of Wight we have developed our own PEP form rather than purchase this from a third party. As such there are differences completing a Hampshire PEP to other PEPs you may receive from other Local Authorities. This PEP has been developed for Unaccompanied Asylum Seeking Children in Hampshire & Isle of Wight. 

Our PEP data form is a word document, it can be saved in word and attached and emailed like any other word document. It does not require you to access or upload it via a secure portal and you will not need a password to access the form. However, please remember that all PEPs are confidential documents and should only be accessed and emailed via secure school/work email. Within Hampshire internal email is kept confidential via the use of ‘mimecast’ and for the IOW Sharepoint. For all PEPs sent to schools outside of Hampshire and IOW please use ‘mimecast’ or other data secure email systems.

This PEP is aimed to be used for the initial PEP meeting for a young person recently arrived into the country (and possibly for the first PEP review. After that time both the social worker and school will have gained more information related to the strengths, needs previous education of the young person and will be required to use the age appropriate Hampshire and Isle of Wight PEPs available from http://www3.hants.gov.uk/cic-virtual-school/schoolsandotherproviders/peps.htm or https://www.iow.gov.uk/Residents/Schools-and-Learning/Virtual-School/Forms-and-Guidance Each of the cells within the different sections of the PEP have the option to a) pre-select existing drop down options b) enter free text c) select date options. N.B Unfortunately one restriction of the software is that we cannot offer a year selection on the date fields only a month selection, so to save time if you type in the date in the same format as the date box it will accept it and reduce the need to arrow back within the calendar itself. The PEP is a statutory requirement, is part of the child’s care plan, and has to be quality assured by the Virtual School and an Independent Reviewing Officer (IRO). As such information is related to the child’s care experiences the immediate short-term education planning affected by these experiences, impact on attainment and use of pupil premium funding are required within a PEP. There are also statutory requirements on Local Authorities and Schools to have clear evidence and data on a wide range of measures for CIC. The design of this PEP will allow the Local Authority & schools to collect the statutory data it is required to hold within the parameters of GDPR.

To complete a PEP you will need to save the document; open it as an editable word document (this is an automatic option on newer versions of word via the yellow tool bar when the document opens); complete all relevant cells and save it as a word file (it is not essential but saving it with the pupils’ initials and date of PEP would help the social worker and virtual school when they receive a copy). If the young person already has a PEP (they are not new to care) any information still relevant from the last PEP can be cut and pasted ‘as text’ into this new form where there are text fields. Once it is complete you will need to send a copy to the young person’s social worker (as usual) For IOW CIC Primary and Secondary schools on the Island will need to upload the PEP through SharePoint.  This is uploaded as a word document (not a scanned pdf as last year). For nursery, post-16 provisions and those providing altenertiave education on the Isle of Wight or schools outside of the IOW without SharePoint the PEP must be sent securely via email to virtual.school@iow.gov.uk (if you click the IOW Virtual School hyperlink on the front page of the PEP this will automatically open an email with the correct address).  A password can be agreed at the beginning the academic year.   For Hampshire CIC the PEP is sent by secure email to Hants. Virtual School as a word document to the PEP inbox at HCC.PEPs@hants.gov.uk (if you click the Hants Virtual School hyperlink on the front page of the PEP this will automatically open an email with the correct address, or type HCC.PEPs@hants.gov.uk into the email address. 
Continued over page
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As this PEP is only an initial PEP further PEP documents and guidance can be downloaded at http://www3.hants.gov.uk/cic-virtual-school/schoolsandotherproviders/peps.htm or https://www.iow.gov.uk/Residents/Schools-and-Learning/Virtual-School/Forms-and-Guidance A Personal Education Plan (PEP) is different to an EHCP in that the targets are short term (termly) and are written following a PEP planning

General guidance & expected PEP practice for Hampshire Children in Care 
What is a Personal Education Plan (PEP)?
Since March 2010, as set down in the education publication ‘Promoting the Educational Achievement of Looked after Children – Statutory guidance for local authorities’ it has been a national requirement that all children in care must have a personal education plan. The statutory guidance can be downloaded from the Hampshire Virtual School website http://www3.hants.gov.uk/cic-virtual-school
It should be written following a PEP planning meeting where the young person, carer, school staff and social worker discuss the current and future educational needs and wishes of the young person.  Decisions around required targets for the young person are made at this meeting based upon the information that has been gathered and provided. The targets must be sensitive to the diverse needs of each young person at that stage in their personal development; and as such no one PEP will be the same. Immediately following the meeting the agreed targets, interventions and/or strategies that will be implemented are recorded within the PEP itself (N.B Feedback from young people in care confirms the importance of a PEP process in which they are listened to, and involved in a positive and supportive way. The young person needs to feel that the PEP is relevant to their needs, and is linked to other aspects of their lives). 
For IOW or Hants. CIC with an EHCP there is a different PEP form that can be downloaded from http://www3.hants.gov.uk/cic-virtual-school/schoolsandotherproviders/peps.htm or https://www.iow.gov.uk/Residents/Schools-and-Learning/Virtual-School/Forms-and-Guidance A Personal Education Plan (PEP) is different to an EHCP in that the targets are short term (termly) and are written following a PEP planning meeting where the young person, carer, school staff and social worker discuss the child’s care plan and how their care experiences affect the current and future educational needs and wishes of the young person. 
The PEP remains an active document for the Child in Care, as the education part of their Care Plan. As it captures the educational history and supports the aspirations of the child in care, in partnership with social workers, parents and carers. It should be updated routinely; and is robustly monitored by the Virtual School, social care and by Independent Reviewing Officers.
An Effective and high-quality PEP should:
be a comprehensive and enduring record of the child’s experience, progress, and achievement (academic and otherwise); 
be linked to “but not duplicate or conflict with” information in other education plans, including an EHCP and IEPs;
identify developmental and educational needs (short and long term) in relation to skills, knowledge, subject areas, and experiences;

Continued
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set short term targets, including progress monitoring, against each of the areas identified against development and educational needs;
The PEP should reflect the importance of a personalised approach to learning it should set long term plans and educational targets and aspirations (e.g. in relation to public examinations, further and higher education, work experience and career plans and aspirations
Identify actions for specific individuals intended to support the achievement of agreed targets.  
See DfE Guidance for further detail https://www.gov.uk/government/publications/designated-teacher-for-looked-after-children
                                     																
Opening the document as an editable word document
The PEP has been created within Windows 16 and is compatible with all versions of word. However, if your school does operate on an older version of word the document does not always open as an editable document which you will need to set up as outlined below.

Step 1: Download the document from the Virtual School Website http://www3.hants.gov.uk/cic-virtual-school/schoolsandotherproviders/peps.htm
Save the document and rename it for your school and pupil. Suggested file name which helps central file matching within children’s services
Surname, First Name-School Name term and year
e.g. Smith, Lisa – Littlemore Primary Aut 18

[bookmark: _Hlk519581013]Step 2: Open your saved document the word document it may open with a yellow toolbar below the usual grey word toolbar. If this is visible you need to click on the ‘enable editing document’ for you to be able to write into the document, as it is currently in Protected View 
Once you do this all the fields become live. 

Please Note: You can tab up and down using your keyboard arrow keys to quickly move between cells. Doing this automatically takes you to the next cell.
[bookmark: _Hlk519580908]If you do not get the yellow toolbar and the text fields within the PEP do not allow you to enter text you will need to manually change the documents view into edit mode which you can do by
1. Click on the File tab in the upper left corner > Select Options.>Select Trust Centre in the left pane.>Click Trust Centre Settings.
>Select Protected View >Uncheck all three options under Protected View and Click Ok.
If the documents have the Read-only attribute set, you can go to File>Options>General and uncheck the box for "Open e-mail attachments and other uneditable files in reading view".









If you are cutting and pasting text into the PEP from a previous PEP or other documents, it helps with the formatting if you cut and when you paste> select paste special>Select the last icon ‘keep text only’

Please note: PEPs should be finalised within 15 days of the PEP meeting, by all parties. All PEPs need to be submitted to the Virtual School prior to the relevant term deadline.  Deadlines for 2018/19 academic year are as follows:  30th November, 8th March and 28th June for data returns and auditing.  Please be aware that late or non-submission of a good quality, complete PEP will result in a delay or retention of that terms pupil premium plus grant.
[bookmark: _GoBack][bookmark: Guidance_page_4]
Guidance page  4															Return to the top of the document
[bookmark: _Hlk520173907]‘Initial’ and subsequent PEP Meetings (i.e Annual PEP + 2 Termly Reviews) Where a young person is a) new to school roll, the social worker should lead the Initial PEP meeting otherwise the chairing of the initial PEP meeting will be agreed by negotiation between social worker and designated teacher. Attendees at PEP meeting discuss the education needs of the young person using the information on the PEP document, the EHCP where relevant and any other additional needs identified through assessments such as Hampshire’s PEP Toolkit analysis and SDQ (for further guidance see)
The Designated Teacher leads the setting of educational SMART targets with appropriate strategy and interventions identified, and a review date is set. A minimum of one review is statutory and the Department for Education Guidance advocates a termly PEP. Please Note: PEP reviews are the responsibility of the designated teacher. At the end of the meeting the PEP is retained in school to be shared with key staff to secure the outcomes agreed. A copy of the PEP is posted by the social worker onto ICS; and either DT or social worker email a ‘word’ copy to the relevant Virtual School. For IOW CIC this is via SharePoint for schools on the IOW; and for schools or education providers outside of the IOW via the shared inbox virtual.school@iow.gov.uk For Hants. CIC it is sent via the shared inbox HCC.PEPs@hants.gov.uk A copy is sent by the designated teacher to the carer; and in the case of an UASC a copy should also be sent to Hampshire’s EMTAS service.

A Young person comes into Local Authority Care: The Social Worker notifies the school (if they have one) of the change to the young person’s care status on the day it happens.            

The care placement allows the young person remains on current school roll.              
At the CLA Care Review, (which is carried out within 28 days) the Independent Reviewing Officer (IRO) will review the PEP as part of the overall care plan, checking the current education situation and care provision in place, and ensuring that targets set are realistic and achievable whilst setting high expectations for all young people in care including UASC. 

Whilst the child remains on same school roll. He / she will have an annual PEP meeting, and a termly review. After the initial PEP the annual PEP and reviews are the responsibility of the designated teacher.
If the child changes school in the future either due to school transition or a change in care placement 
[bookmark: _Hlk520173557][bookmark: _Hlk520173558]The ‘Initial PEP’ meeting date is arranged in line with statutory requirements by social worker within 10 working days (or 10 days of school placement). Hants. & the IOW have different versions of the PEP specific to Early Years, Reception and primary, secondary, UASC or pupils with EHCP. The PEP form most appropriate to the child should be accessed by the social worker from http://www3.hants.gov.uk/cic-virtual-school/schoolsandotherproviders/peps.htm or https://www.iow.gov.uk/Residents/Schools-and-Learning/Virtual-School/Forms-and-Guidance (and supported by designated teacher) ensures completion of each section by the relevant person - ensuring that the young person is supported by whoever he/she chooses to be supported by. An UASC may need an interpreter. Sections 1& 2 of the PEP could be populated in advance of the PEP meeting. The social worker (with possible support from the designated teacher) gathers all sections together and provides a copy for all attendees at the meeting. 

[bookmark: _Creating_a_PEP] Creating a PEP - the PEP process timeline 

Due to distance the care placement means a change of school place; or for Unaccompanied Asylum Seeker (UAS) a school place to be sought. Social worker also liaises with Virtual School Education Officer and Best Provision Protocol (BPP) applied                                   



                              

 


Each PEP document contains pages for the young person’s views an
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Initial PEPs are a statutory  document that should be in place 10 days after a young person who has just been taken into care or who is already in care but new to your school. This PEP is intended to only be an Initial PEP and has reduced pages due to anticipated gaps in the young persons educational history. HCC & IOW advise 1 annual & 2 termly PEPS per year So DTs will need to access the most fitting PEP for the termly review from our Virtual School websites (See bottom of P3 of this guidance 
 Date of enrolment PEP: Select the date when the young person started at your school 
A copy of the final version of this PEP should be sent to both the virtual school and social worker. On the IOW this will be though usual SharePoint (or virtual.school@iow.gov.uk for out of county schools) and for Hampshire via the shared inbox HCC.PEPs@hants.gov.uk













School Name: Type into the text field your schools name, DFE number, (as we do have some schools with the same name) Select IOW or HCC District or type in your county if you are outside of these two counties. 
Select your schools age range. 
Type in the name of the social worker, designated teacher and their email addresses information which we are able to collect under GDPR as part of public duties. 
The social worker should complete which social care district and team they are from (for the IOW please select IOW from the drop down) and add the pupils Swift/Social Care ID 











Swift ID or Social Care ICS: Is a child social care identification number. Please ask the social worker for this detail if you do not have this information




My Other education settings: If the young person attends college, alternative provision, a pupil referral unit or education centre please type in the name of the provision and the dates they started to attend here








[bookmark: _Guidance_page_5][bookmark: Guidance_page_6]Guidance page  6
Return to Section 1
This section is for the social worker to complete and allows for insight into the young person’s needs in relation to school, learning and holistic development. They can provide background and historic information on the young person. It is vital that it is understood by the school why the young person came into care and the nature of their life experience prior to that point. The social worker provides insight into the young person through observation of attitude, relationships and response within the care environment. Again, reviews provide the opportunity to note both change and new insight. The Social Worker is responsible for ensuring the young person has a robust PEP and that this is reviewed and updated regularly as their needs change.
The social worker should provide this information at the Initial PEP and update this section in advance of any termly PEP & Annual Review meetings



















. 




Return to Section 1
[bookmark: Guidance_page_7]Guidance page  7
The pupil is new to care so they may be on an emergency or temporary care order pending a court date. This means the final care plan is not in place; however, the information to date is still very significant to planning education support. The care plan should be available for the DT to see and will address these bullet points.
The social worker should comment on each of these bullet points specifically to support the school planning for education support and interventions and to enable adults in the school to understand the care context and the very specific needs of the pupil.The care plan contains current and historical information that will help the school know what the young person has experienced to date so they can plan to best meet the needs of the pupil. The SW may send you secure copy. If not the DT should request to see it. In addition the social worker should share any other relevant information about my needs not recorded in the care plan







The SW should comment on each of these elements according to what is contained in the care plan. This context will support the school in planning to meet the pupils needs and proactively plan support.










Statutory guidance states a SW should attend two PEP meetings annually. Good practice in Hampshire and the IOW is for a termly PEP. As the young persons key worker we would value social worker providing and updates on their view of the child from their home visits, even if they cannot attend a meeting. If there is no change to report on the care plan or the child this comment in itself is an update that indicates the SW has seen and commented on the PEP Once A PEP is completed it is the social worker’s responsibility to ensure the PEP is on ICS. Either the social worker or designated teacher should ensure a copy is also sent to their Virtual School
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For children that have been taken into care there are often protective factors in place around contact and permissions Page 4. 
The social worker for the child/young person holds parental responsibility even when the child/young person is living at home with parents or is in a foster care.
The school need to ensure that only the correct people are contacted, and information shared with them in relation to the child/young person. As such the DT must share contact and permission arrangements with key staff, including office staff.
As such the child/young persons’ social workers must ensure the information on pages 4 & 5 are correct and updated regularly in line with any court proceeding around the care orders. So the school can carry out its safeguarding duties effectively. 
Pease note in particular: In relation to any request for any leave of absence the form to schools must be signed by the district manager for children and families. It is not enough the form is completed by a parent or carer (as they do not have full parental responsibility). CiC may have restrictions on where they can travel, and schools must seek permission from the social worker before taking them on any school trips. 




















	The social worker should ensure the designated teacher is aware of who is entitled to a copy of a pupils PEP in line with GDPR and the child’s care status 








[bookmark: Guidance_page_9]
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For a PEP to meet statutory requirements then the following people must attend the PEP meeting:
Young person for which the PEP is about. They do not need to attend all of the meeting (and many aspects of the PEP can be written in advance). They should be supported (relevant to their age) to share their views about their own education and contribute to the actions agreed over the next term which will help them with their education. If they refuse to attend the meeting then pupil voice should be gathered in advance to inform the meeting; and a subsequent meeting (post PEP) should be held with the young person to finalise the agreed PEP action plan.. 
 Carer/ Parent or Adopting Parent. They should attend the whole meeting and their views sought. Some carers/parents are not forthcoming with their views and again these can be sought in advance from a phone call or other meeting such as a pupil progress meeting
Social Worker who will lead the initial PEP and after this the DT will chair future PEPs. However, the SW as the young person’s key adult is required to attend PEPs. If a social worker is unable to attend a future PEP meeting then wherever possible the date should be rearranged.  Where this is not possible they should contribute to the PEP via an update onto the PEP and possibly a phone call and email with the DT, and Carers; and in the next contact meeting with the young person.
Designated Teacher. The DT is a statutory school role, the DT has expertise and training to ensure PEP targets are tightly focussed on meeting individual pupils educational needs and are of a high standard. Although other school staff may join or chair PEP meetings the trained DT is responsible for the PEP and must be involved in the writing of the actions and quality assure all PEP plans
Other professionals and adults may attend PEP meetings in discussion with the young person and parent/carer so they can input in their role to the actions and interventions agreed to secure the very best educational outcomes 

For newly arrived and/or UASC pupils a language interpreter may also be required









Return to Section 2
[bookmark: Guidance_page_10]Guidance page 10 



Needs Analysis Initial PEP:
An intial PEP must focus on stabilsing the pupil, ensuring they feel safe and securly attached.  Schools should consider adult relationships for any child new to care or/and new to the school to ensure there is a key adult (attachement figure) in place as a core strategy. If the pupil is new to your school and new to care; it will not be possible to complete the PEP Toolkit Needs Analysis (good practice would be to complete 3 months after the intial PEP once the school has got to know the pupil).  If the child is new to care but not new to the school then it is advisable to complete the Needs Anlaysis on the basis of previous observations. 

Strengths and areas for development can also be drawn from the pupil voice. 
























For more advice on strategies to support mental health visit: 
https://www.nspcc.org.uk/preventing-abuse/child-protection-system/children-in-care/emotional-wellbeing-of-children-in-care/
https://www.mentalhealth.org.uk/sites/default/files/mental-health-and-prevention-taking-local-action-for-better-mental-health-july-2016.pdf
http://www.fph.org.uk/school_mental_health_promotion
https://www.mentalhealth.org.uk/publications
http://www.partnershipforchildren.org.uk/teachers/zippy-s-friends-teachers.html
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The young person gives his/her own thoughts, supported by whoever he/she feels best suited to do so. An interpreter may be needed by Unaccompanied Asylum Seeker Children/young people or by others whose first language is not English. The pages dedicated to the young person’s views are formatted in an age appropriate way but can be completed/supplemented in any way that the young person chooses; a supporter can act as scribe; diagrams and pictures can be created by the young person; even mind maps have been used by some. In PEP reviews young people can reflect on changes in the way they think, feel and perceive their needs. Reviews provide an opportunity to voice changes in their point of view or new thinking.

If the young person refuses to attend the PEP meeting their views can be sought in advance of the meeting on this page and shared at the meeting on their behalf.

It is the responsibility of the DT to ensure the child has voice in the PEP process and completion (as per the Statutory Guidance). This can be done in various ways and professional judgement will determine this. Some pupils are happy to complete this and share at the meeting, but others feel uncomfortable with this and require further adult support. One example of this could take the form of an adult annotating the pupil’s responses and sharing on their behalf at the meeting.
The pupils voice, where appropriate should be evident in targets and the interventions. For example, if the pupil expresses they would like more help with Maths, this should be recognised in the action plan.
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Section 3b: The carer has an important role in ensuring that the PEP is of the highest quality. Where a child is not new to their placement, they can provide important background and historic information. They can also provide details regarding responsibilities and permissions. They should see their role as one of partnership with the school, having the same shared, high expectations, supporting and encouraging the young person in every aspect of their learning and making the school aware of any barriers in and outside of school which may be affecting their engagement with education. The carer will want to consider their role in relation to supporting the young person to reach their targets, and future aspirations; and their may be actions for them within the final action plan. They may ask for guidance from the school to enable them to do this most effectively, for example and shared strategies to secure good attendance. Carers can advocate for their young person and will want to question and challenge any instances of low expectations or poor progress. The DT or social worker should consider how to best support carers in advance of a PEP planning meeting or review. For example, any reflections carers can make, record, and bring to the PEP meeting about their view of the young persons’ current progress or barriers, will be advantageous to the quality of the discussion within the PEP meeting. DTs should encourage carers to share in detail their thoughts on the pupil’s educational provision
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Section 3c is the section where targets are set and to which all other sections are directed. It is completed by the designated teacher as a result of the discussion at the meeting and what analysis tools have used. The designated teacher, class teacher and other school staff should identify how the teaching, interventions and strategies should be developed or implemented to overcome barriers and meet individual needs in order that the young person progresses, attains, and flourishes. The quality of teaching and other strategies and interventions implemented will be evaluated in terms of impact at each PEP review meeting and so enlighten and inform future decision making.
As per statutory guidance, PEP targets should be SMART and pupil focused.(see appendix…)

DTs can list here the wider interventions planned to support the pupil with their targets. For example they may have access to a counsellor or a key adult – but it is not a pupil target to got to counselling or see the key adult.
A wider intervention might be CPD for teachers in order to better understand and support the pupil.
The pupil might have nurture group or 1-1 tuition support which will support a target – but attending this support is not the target itself. 

[image: ]List here all the adults who will support the pupil with this target; including if appropriate the carer or Social Worker.










Cont. next page….
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Initial PEPs: 
Transitions magnify vulnerability and therefore the focus of the targets and the interventions in the plan should be centred around ensuring the child feels safe, valued, and is working towards becoming securely attached in school. 

For newly arrived and/or UASC pupils:
Ensure every member of staff reflects on how the pupil will be feeling ‘am I safe?’ ‘Do I matter? And consider helping all members of staff to adopt approaches in class that will enable a positive response to these quests.
Ensure the availability of the key adult is maximised
It may be appropriate that members of staff have CPD to enable them to understand and respond in an appropriate way.
Consider a new arrival ambassador
Additional support and guidance: http://www3.hants.gov.uk/emtas http://www3.hants.gov.uk/education/emtas/supportinglanguages/ambassadorscheme
http://documents.hants.gov.uk/education/EMTASAsylumseekersandrefugeechildrenincountyGuidance2014-09-11.pdf
http://documents.hants.gov.uk/education/EMTASUASCguidanceforschoolsoutsideofHampshire.pdf
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Use of Pupil Premium Plus (PP+) Funding 

All PEPs must be sent to the Virtual School. On the IOW this will be though usual SharePoint but now as a word document and for Hampshire via the shared inbox HCC.PEPs@hants.gov.uk The new PEP data form allows the Virtual School to pull off the data it requires as corporate parent.

PLEASE NOTE:  If schools complete the current spending table fully with detail related to planned spending and expected impact measures then schools will not be asked to complete the additional current termly reporting requirements on the use and impact of Pupil Premium Plus.
All schools and county councils have a statutory duty to report on the use of pupil premium funds. This report should include clear evidence of impact measures that spending has on improving educational outcomes particularly on academic progress and attainment. This section of the PEP should link to table 2b of the PEP on changes
There are clear conditions of grant in relation to the use of pupil premium spending and more guidance can be found both at Hampshire’s & IOW’s Virtual School website and the DfE website




In both the Isle of Wight and Hampshire, the pupil premium plus funding is passported to schools termly where they have IOW or Hants. CIC on roll. It is the Virtual School Headteacher’s expectation that this funding is used by schools on individual CIC and not pooled to fund wider school initiatives. Funding should be used to 1) increase attainment 2) Improve rates of academic progress 3) Support a pupil’s social, emotional and mental health needs where they are currently presenting as a barrier to their active engagement in their education.
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Inserting documents into the PEP

On the second to last page of each PEP is a space that schools can insert tables, charts, scanned documents etc. The instructions are included on the page to use your keyboard press ALT and N of ALT and J (depending on your PC and software). When you press these keys together you need to look for the changes the function makes to your word toolbar/ribbon at the top of the page which will now have capital letter in square that have appeared. 


[image: cid:image004.png@01D41F53.7422C790]
Depending on what item you want to insert and your PCs software you either:
Click on the Object icon and it will give you the option to insert an object (which is suitable for file types such as photos or scanned images)
Or
Click on text from file which will either go straight to your document files enabling you to select the document whose text/information you want to import (such as a school report or a professional’s assessment report); or it will open a grey dialogue box and you will need to select from file.
You then browse your documents to locate the file object or text you wish to insert and click ok. The document will then appear within this page.
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What will help me to build on my strengths, do my bestand be my best?

As a carer you may want to consider:

Is your young person keen to come to school, have a good relationship with staff and their peers? Do you think they
are confident to ask questions ortalk to their teacher about their leaming? What is your experience of them
completing homework and do you feel confident enough to support them completing it? Do you feel they are keen to
take partin school tips, clubs etc and have they shared with you any particular anxieties, worries or concers?

As a carer you can either:
Send in your own words so that the school and social worker will paste into this section of the PEP, or share your
thoughts at the meeting and the designated teacher will record the main points in this section

What are the key priorities for the parent/carer for this meeting and the action plan:

P (carer) said that at irst, there were times when M (pupi)) was reluctant to come to school. He was visibly
anxious and would run away across the playground when it was time to go in. Now he is settied, he looks
forward to coming into school and he comes out with a smile on his face, indicating that he feels safe and
secure in the school environment.

Mis developing good relationships with his peers, and he responds well to adults at school. He has been
able to tell his teacher when he’s felt worried, which is huge progress from last year when he would be
upset but unable to verbalise this. P and J (carers) are still working on understanding emotions at home
with M.

M has just started reading tuition at home with N for half an hour a week. P and J understand how
important reading is and P often makes up stories for the boys at bedime.

J said that when P first joined the nurture group she wasn't sure at first, believing it to be a group for
children with behavioural issues, but says she can now see how it will support M's social and emotional
development and readiness for leaming in a classroom environment.

M recently had a Language Links’ speech assessment which showed that he has severe delay in
understanding. Jsaid that P was seen by speech therapy in pre-school and signed off, and was also signed
off for global development delay last year. J asked whether she should take P back to the paedatrician,
but it was decided that it would be best to see how P responds to speech therapy once the referral has
been made.

Pand J also reported that M regresses in behaviour at times, choosing to copy their grandchildren who are
‘much younger and appearing to be much less independent. The group discussed how this could be to do
with wanting attention, or missing out on early childhood experiences and the need to re-enact them.

1.

2. For staff to understand how delayed early development and attachement difficulties affect his emotional
responses and the observable behaviours.

3. Click here to enter text.
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